
TeamConnect® Enterprise
7.1.0 Patch Bundle 1
Release Notes

TeamConnect® Enterprise 7.1.0 Patch Bundle 1 (PTC7100001) resolves the following issue.

NOTE: This patch also includes fixes from TCE 7.0 PB6 and TCE 7.0 PB7.

Release Summary

New Portal Panes
In this release, a collection of ten new portal panes has been added, enriching the library of
components available for crafting home pages. These new portal panes are designed to help users
understand information faster and focus on critical tasks and decisions.

Key enhancements incorporated into the home page portal pane include:
1. Display of configurations made in Portal Panes setup directly on the home page, seamlessly

integrated with TeamConnect installation.
2. Introduction of new parameters for the Portal Pane, now accessible via intuitive dropdown

menus, eliminating the need for manual text input.
3. Enhanced horizontal alignment for improved visual coherence of home page portal panes.
4. Integration of Font Awesome icon and family dropdown, simplifying the addition of icons to

portal panels, thus enhancing visual appeal and functionality.

TeamConnect O365 Add-In 4.0 Update
In our latest 7.1 release, we introduced TeamConnect Outlook Add-in 4.0, marking a significant
advancement in our suite of productivity tools. This release includes exciting updates to our
appointments and tasks functionality:

● Appointments:
○ For users not currently using appointments in the plugin, you can upgrade now!

Appointments are available in the new Add-in.
○ For users who rely on Appointments in the Plug-in (legacy Outlook integration),

appointment migration will not be available until May 2024 (target release date),
please wait until then to upgrade.

● Tasks:
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Tasks will not be available in the new Outlook Add-in until November 2024. If you rely on tasks with
the legacy plugin or simply wish to start using them, please schedule your upgrade after the
November 2024 release (target release date).

Features & Enhancements

TeamConnect O365 Add-In 4.0 Update- Prepending the matter name on the
appointment subject
When creating an appointment in TeamConnect and syncing it to Outlook, the matter name will be
prefixed to the subject of the appointment for the invitees. In the Add-in, the synced appointment will
display as "Mattername - subject title". This functionality is available only if the matter is selected during
the creation or editing of the appointment in TeamConnect, and the sync to Outlook flag is activated.
This behavior remains the same when creating and editing appointments in Outlook.

Kindly note the following details regarding existing appointments:
1. For existing appointments, editing the matter name in TeamConnect will automatically update

the matter name in Outlook. Similarly, editing the matter name in the Add-in will replace the
matter name in both Outlook and TeamConnect for existing appointments.

2. If the matter name is removed in TeamConnect, it should be promptly removed from the
appointment and updated in Outlook. This process bypasses security assumptions, allowing
invitees to view the matter name on the appointment, even if they do not have explicit
permissions to see the matter name in TeamConnect.

3. If the user modifies the appointment subject title, the matter name is prepended in the updated
subject line. Additionally, if the user deletes the matter in TeamConnect, the synced
appointments will be automatically deleted.

4. The organizer (user) has the flexibility to edit or remove the title from Outlook directly, without
using the Add-in. If they wish to reset it with a prepended matter and subject, synchronization
will occur from TeamConnect or the Add-in.

If the organizer lacks permission for the matter, it will be indicated as secured in the Project field.
NOTE: Changing a matter's name will not automatically update the matter names on Outlook calendar
events linked to that specific matter. To synchronize these changes, use the "Force Sync/Sync to
Outlook" button in TeamConnect.
If the user needs to replace the matter name in the Add-in with a new matter name, the invite should be
in compose mode.
Tracking Code: TC-49404

Improvement: In Invoice and My Approval pages, the column width persists as per the user
preference.
Description:When a user modifies a column width, whether it is default or optional, the column width
setting is saved to the user's preference and the value is saved in the database. For more information,
click the Invoice page and My Approval page.
Tracking Code: TC-49971, TC-49972
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Improvement: In the Invoice page, the selected "View" persists in invoice review.
Description: In the Invoice page, the persistence configuration is specific to Invoice Review. If the user
changes the "view" value, their preferences will take precedence over the default and the page will
always load with the desired configuration. For more information, click here.
Tracking Code: TC-49917

Enhancement: Native Reports can be accessed outside of TCBI.
Description: The Reports tab now features an improved user experience. Legacy reports has been
renamed to Native reports and introduced a submenu under the Reports section in all dropdown
menus. This ensures seamless access to both Native reports and Sisense reports, even if the Sisense
link breaks. Users can now easily navigate between these report options based on their preferences.
Additional Information: The All Services portal pane on the TeamConnect homepage will not display
the Native reports option. If users click on Reports within this pane and TCBI is not installed in their
instance, they will be redirected to Native reports.
Tracking Code: TC-48899

Enhancement: New home page portal panes will be delivered with TeamConnect installation.
Description: The new home page portlets will be available in the system. After upgrading, a
TeamConnect designer can navigate to Setup > Portal Panes, add a new Portal Pane and select
Dynamic Content, where they can select 9 new portlets from the Class file dropdown.
Tracking Code: TC-48420

Enhancement: In Portal pane settings, the option under Content Type called “Custom Content” has
been renamed to “Dynamic Content”, and the Class Name field is now a drop down rather than text.
Description: When the user selects content type there will now be an option for “Dynamic Content"
instead of "Custom Content" which functions the same manner as picking Custom Content, only the
name has changed. After choosing Dynamic content, the Class Name field will be a dropdown field
allowing selection that will show a combination of the pre-defined portlets as well as any class files
found in the portal panes directory of the TeamConnect file structure.
Tracking Code: TC-49374

Enhancement: Better horizontal alignment of the home page portal panes.
Description: When showing two or three columns, the width of each column does not alter dynamically
in response to the contents of the portal panes; instead, they display according to the percentage of
width specified in the setup. Introduced two new options to regulate the number of columns (dropdown
for 1, 2, or 3) and the relative percentage of widths. The user can use 33:33:33 to ensure that the portal
panes are split evenly.
Tracking Code: TC-49054
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Enhancement: Ability to move portal panes around and edit settings without having "Show Title"
enabled.
Description:

● When a user edits a portal pane in setup > home pages > content and unchecks "Show Title"
before saving, the title remains visible on the content page. There will be an indicator after the
name of the portal pane indicating that the title is hidden. This functionality allows the user to
edit and move portal panes around on the home page content even if they don’t want the title
bar to appear on users' home pages via the front end.

● When the "Show title" option is unchecked in portal panes, the title bar will still appear, but
without the title text and all other controls are still available (edit, minimize/maximize, and the
ability to grab the title bar).

Tracking Code: TC-49362, TC-49375

Enhancement: Introduced Font Awesome icon and family dropdown for adding icons to portal panels.
Description:When editing the parameters for portal panes, two fields have been introduced:

● “Font Awesome Icon Family” dropdown (Solid, Regular, or Light) which controls the look of the
selected icon (This field is available under Action portlet).

● “Custom Font Awesome Icon” text field where the user should type or copy/paste the name of
the font awesome icon they want to use, with the “fa-” at the beginning.

Tracking Code: TC-51173

Fixed Issues
Issue: User reporting similar Accessible Names for interactive controls that are causing issues.
Tracking Code: SUPPORTPRI-69060
Case Number: 2023-0920-7992681
Reported Version: TCE 7.0

Workaround
None.

Pre-Requisites
None.

Steps to Reproduce
First Issue:

1. Login to TeamConnect.
2. Go to the Legal tab and open the matters.
3. Hover on the edit button and it shows edit instead of accessible names. Screen reader users 

may have difficulty determining the function of the button.
Second Issue:

1. Login to TeamConnect.
2. Go to the Home page and the minimize/maximize button is not having exact accessible names.

Expected Results of Steps
Accessibility Names are different enough to not cause confusion.



Actual Results of Steps
Accessibility Names are not clear to users.

Root Cause Analysis
Implemented fixed table columns widths for interactive grid for project list.

Issue: Global search having issue with Special character and blank space.
Tracking Code: SUPPORTPRI-67344
Case Number: 2023-0221-7687777
Reported Version: TCE 6.3.5

Workaround
None.

Pre-Requisites
Patch 22 on TCE 635

● Create matter record with below names:
○ BWI-R-0963/10
○ A/C Damage.
○ Winter Operation 2016-2017 Publication.

● Enable "FOCUS EXACT MATCHES IN SEARCH RESULTS" from admin > Search results
settings.

● Go to the global search index page and index the dispute object.

Steps to Reproduce
1. Run a Dispute Global Search for “0963/” (with quotes).
2. The screen will refresh and show the results page with nothing on it, but on the left side, you'll

see there are records present.
3. Likewise Run a Dispute Global Search for "Winter Operations'' and "A/C Damage" (with quotes)

you will see the same behavior as above.
NOTE: Error is only triggered with a special character on space inside quotes.

Expected Results of Steps
Results should be displayed.

Actual Results of Steps
Blank screen is displayed.

Root Cause Analysis
Was using equals to check for exact match but Elasticsearch returns multiple <em> tags for phrases
with special chars.

Issue: Global Search - “Show Exact Matches Only” fails to exclude non-exact results.
Tracking Code: SUPPORTPRI-66762
Case Number: 2023-0117-7625629
Reported Version: TCE 6.3.5

Workaround



None.

Pre-Requisites
None.

Steps to Reproduce
In our TeamConnect (TC) v6.3.5 production environment (also tested with 6.3.5 patch 21 in our TEST
environment):

1. Run a Dispute Global Search for the word 'damage' (NOT in quotes). TC shows 3,217 results
but this includes variations of the term, such as "damages" or "damaged".

2. Check the "Show Exact Matches Only" checkbox in the left-hand filter panel and click Apply.
3. When the screen refreshes, TC shows the exact same thing as before: 3,217 results, with the

same matters listed as before, even the ones that are NOT exact matches (e.g. "damages",
"damaged", etc).

4. Re-run the search but use "damage" instead (in quotes". TC shows the same exact result,
3,217. The quotes do not change anything.

5. Re-run the search using variations of the word damage: "damages", "damaged", "damaging",
etc. Both with or without quotes. These all have the same result as the original 'damage'
(without quotes).

Expected Results of Steps
Quotes should produce more direct results.

Actual Results of Steps
Both with or without quotes, these all have the same result as the original 'damage' (without quotes).

Root Cause Analysis
Filtering is not done correctly.

Issue: Multi-select field Search Filter Criteria value does not get added to list entry in custom search.
Tracking Code: SUPPORTPRI-62326
Case Number: 2021-0618-795104
Reported Version: TCE 6.3.5

Workaround
None.

Pre-Requisites
Custom Search Filter with Multi-Select Search field.

Steps to Reproduce
1. Create a Multi-Select Search field in the Filter Display of Custom Searches under Matter Object

Definition (for Amgen, under IP Lit Obj. Definition).
2. Once added to the Search, navigate to the Custom Search under Matters tab.
3. Add the newly created Multi-select Search Field as one of the Filter Criteria.
4. Type something from the List in the Search Box and once you see it in a list below the box, click

on it.

Expected Results of Steps



The selected value must be added to the Pick list on the right side of the Search box as one of the
criteria and work as a Filter Criteria.

Actual Results of Steps
The selected value stays in the box, doesn't get into the pick list for Filter Criteria and it doesn't aid with
the search at all.

Root Cause Analysis
There are 2 bugs in this:

1. While generating a BindAutoCompletion request, we are not properly encoding the url. For
example, "[" in the field name is giving a javascript error of invalid url.

2. postAutoSuggest and addSelectedOption js custom functions are missing in
Core/webui-parent/webui/src/webapp/scripts/yui-user-defined.js file.

Root cause of this issue is that this file could have been replaced directly without incorporating the
custom changes made by us when we upgraded to yui 2.9.0. Whenever we upgrade to a new version,
we have to make sure all the custom changes are duly incorporated in the new yui files.

Issue: Exact tag match applied to search results when search result isn't exact match.
Tracking Code: SUPPORTPRI-65172
Case Number: 2022-0616-948013
Reported Version: TCE 6.3.5

Workaround
None.

Pre-Requisites
Setup Elasticsearch.

Steps to Reproduce
1. Login to TeamConnect.
2. Create a dispute record Augus.
3. Go to Admin > Admin setting > Search result and under “Other setting” enable "FOCUS EXACT

MATCHES IN SEARCH RESULTS" check box.
4. On the global search textbox, type in "augue" as the search value and select ALL and hit the

search button to execute.
5. The first result will have an Exact match tag even though the value is "Augus" and doesn't

match the search value "augue".

Expected Results of Steps
It should not have an exact match tag on the result if it's exactly not the same.

Actual Results of Steps
It's showing an exact match, even if it's not.

Root Cause Analysis
Plural form of stemmed words is considered exact.



Issue: The client is unable to fetch the matters with an embedded field which has no value.
Tracking Code: SUPPORTPRI-67542
Case Number: 2023-0531-7862451
Reported Version: TCE 6.3.3

Workaround
None.

Pre-Requisites
● Create an Involved Embedded object under Matter.
● In embedded objects, under Unique Id select "By using default numbering (a default unique ID

will be generated but will be hidden from the user)".
● Under Name select "Automatically name Matter Tendor using a pattern of the object attributes''

and add items:
○ with null format.
○ contact with null format.
○ parent with null format.

● Add a custom field.
● Add List display.
● Add Embedded object block in Matter Object view.
● Add filter criteria in custom Search under Dispute object for Tendor party with Contact name.
● Add result criteria in custom Search under Dispute object for Tendor party with Contact name.
● Create few Dispute records with and without Embedded records.

Steps to Reproduce
1. Navigate to Dispute and go to Custom search.
2. Add Embedded field in Result display.
3. Perform the Custom search and you will see all the records with and without values in the

Embedded field.
4. Add a filter to search for an Embedded field with a value.
5. We can see the records having values in the Embedded field.
6. Add a filter to search for an Embedded field with no value.
7. We can see no records displayed.

Expected Results of Steps
We should be able to see the records having no values in the Embedded field when the filter to search
for Embedded fields with no value is applied on Dispute.

Actual Results of Steps
Unable to see the records having no values in the Embedded field.

Root Cause Analysis
Inner join being constructed for related objects which returns no rows if no record present for related
objects. Code changes done to use Outer join for related objects.

Issue: Unable to GET record data for custom object - web services.
Tracking Code: SUPPORTPRI-64823
Case Number: 2022-0222-895018
Reported Version: TCE 6.2.1

Workaround



None.

Pre-Requisites
● A custom object.
● Records in a custom object.
● A user with full permissions and security rights to view the record in TeamConnect.

Steps to Reproduce
1. The client is trying to extract record data using a 'GET' and the fastest way to test is to put a

basic web service call directly into the browser url.
2. In an example, the client logged in as himself (he has full permission and security rights and

demonstrated that he can view the records in the application). He attempted a GET via a URL.
He was not able to get the data and there were errors in the logs.

3. However, the client can access records from all other objects using this method and can even
get a list of the records by entering a different call.

4. The issue occurs with existing records but also with new records. It is not clear if the volume of
custom fields is the issue or if there is a data or configuration issue with the object that is
causing a 'GET' failure. The client also has an old imanage integration, but the imanage rule
was off and new records were still affected.

Expected Results of Steps
They should get a json output of the record data.

Actual Results of Steps
They get:

● Error 500--Internal Server Error
● From RFC 2068 Hypertext Transfer Protocol -- HTTP/1.1:
● 10.5.1 500 Internal Server Error.
● The server encountered an unexpected condition which prevented it from fulfilling the request.

This appears in the logs:
[ERROR] [AbstractFaultChainInitiatorObserver] AbstractFaultChainInitiatorObserver.onMessage - Error
occurred during error handling, give up!
org.apache.cxf.interceptor.Fault

Root Cause Analysis
No handling for permission issues with certain fields/relations. Adding secured serializers.

Issue: Search view column wrapping not functioning with long column name.
Tracking Code: SUPPORTPRI-66821
Case Number: 2022-0915-983986
Reported Version: TCE 5.2.1

Workaround
Rename the search view column name.

Pre-Requisites
Search view with a few columns and a large column name.

Steps to Reproduce
1. Go to a particular search view in the setup.



2. Create a new column or edit a column name to a long name ( e.g :Interviewee (Historical
eDiscovery/Data Requests)).

3. Save the search view.
4. Log out and Log in.
5. Check the column width in the teamconnect user interface.

Expected Results of Steps
The column width in the search view in the team connect UI must be displayed according to the column
width set in the setup.

Actual Results of Steps
When a long name is used for one of the columns, the column in the teamconnect UI takes the size of
the name instead of the size allocated in the setup.

Root Cause Analysis
Should implement fixed table columns widths for interactive grid for project list.

Issue: System Error Occurring after canceling a Custom Search.
Tracking Code: SUPPORTPRI-66969
Case Number: 2023-0208-7651912
Reported Version: TCE 6.3.4

Workaround
None.

Pre-Requisites
None.

Steps to Reproduce
1. Access any module e.g formal matters and click on Custom Search for Disputes.
2. Do not enter any criteria and click on Search.
3. While the Dialog Box "Search in Progress" is showing, click on Cancel (the Dialog box

disappears).
4. Click on Search again.
5. A system error is received.

Expected Results of Steps
When clicking Search after canceling a Custom Search, Search should run as expected.

Actual Results of Steps
An error occurs after you click Search after previously canceling a Custom Search.

Root Cause Analysis
No Action Method available to handle cancelSearchFromSpinner action. Added a method to handle this
instead of throwing NoSuchMethod Exception.



Issue: Not getting autocomplete results when performed custom search operation for the names that
have special character.
Tracking Code: SUPPORTPRI-67400
Case Number: 2023-0508-7835650
Reported Version: TCE 7.0

Workaround
The user has to search. However, sometimes that yields no results and the user has to search
again. So there can be several extra clicks.

Pre-Requisites
This is more noticeable when there are multiple contacts. Recommend having many contacts with the
same first name and distinct last names (like Test User1, Test User2, etc.).

Steps to Reproduce
1. Go to All > Invoices.
2. Click on Custom Search.
3. In the Vendor search box, type in the first name of the contact.
4. Observe the name of the contact shows.
5. After the first name, add a space and try to type the last name.
6. Observe the second name disappears

Note: This is reproducible on any contact search. For example, it is reproducible when selecting a
contact for a new user or selecting a user for a matter assignee.
The client uses this to search for vendors.

Expected Results of Steps
The type ahead should let you enter more than one word in a name.

Actual Results of Steps
The type ahead stops when there's a space.

Root Cause Analysis
The URL parameters are encoded and needs to be decoded to get actual values after the library
updates from TCE 7.0

Issue: Validation Rule Not Triggered on 'Is Contains' Logic When we add more than one record which
contains restricted value.
Tracking Code: TC-50731
Case Number: 2023-0626-7891754
Reported Version: TCE 7.0

Workaround
Possibly make a custom action.

Pre-Requisites
NA

Steps to Reproduce



1. Create a custom object (user can use an existing object if you want) - This shall be called the
'Parent Object'.

2. Create a child object called 'Allegation Table'.
3. Go to the custom field tab and create a custom field called 'Allegation Code'. It is a 'Text' field

type.
4. Go to the Search View tab and create a search view called 'Allegation Code Table'

a. Should be a Search Module with Auto Search On.
b. Filter Display should include the Name, Number, and Allegation Code field.
c. Results Display should include an object link, Name, Number, and Allegation Code field

5. Go to the Parent Object.
6. Go to the Embedded tab.
7. Create a new embedded object called 'Allegation Event'.
8. Go to the Custom Field tab and create a custom field.

a. The field name is 'AllegationType'.
b. The label is 'Allegation Code'.
c. The field type is a custom object linking to the 'Allegation Table' child object.
d. The Search View is the 'Allegation Code Table' view

9. Click the List Display tab and add the following:
a. Name, Number, Allegation Code (refers to the AllegationType display key)

10. Go to the Parent Object.
a. Create a rule called 'Qualifier Check' - Unique key = 'QACK'
b. Set the rule type to Validation.
c. Activate the rule.
d. Set the trigger to 'Update'.
e. Set the qualifier to Current Object -> Child List -> Allegation Event -> DetailList ->

Allegation Event -> Allegation Type -> DetailList -> Allegation Table -> Allegation Code.
f. Set the operator to 'Is Contains' and put 'Walk' in the right argument.
g. Click the Action tab and put in a rejection message

11. Go to the parent object and add the child object to your parent object view.
12. Go to the TeamConnect Application.
13. Make sure you add the child object and embedded object to your group permissions.
14. Go to the 'Allegation Table' child object.

a. Add a record named 'AT - Walk' with an allegation code of 'Walk'.
b. Add a record named 'AT - Run' with an allegation code of 'Run'
c. Add a record named 'AT - Skip' with an allegation code of 'Skip'

15. Create a new parent record.
a. Within the parent record, add three Allegation Events:

i. AT - Walk
ii. AT - Run
iii. AT - Skip

b. Save.
c. Edit the record and remove either 'AT - Walk' or 'AT - Skip'.
d. Save.
e. Observe the rule does not fire.

16. Remove all of the Allegation Events.
a. Save.
b. Edit the record and add 'AT - Walk'.
c. Save.
d. Observe the rule fires but the 'AT - Walk' is still added.
e. Add 'AT - Run'.
f. Save.



g. Observe the rule is not triggered.
17. Remove all of the Allegation Events.

a. Save.
b. Add the embedded records and add 'AT - Walk' and 'AT - Run''.
c. Save.
d. Observe the rule is not triggered and both embedded records are added.

Expected Results of Steps
The rule should fire because the prohibited text is there.

Actual Results of Steps
When there are multiple embedded records (and at least one of them includes prohibited text defined in
the rule), rule does not fire and the parent record is saved. In the client's previous version, the rule was
triggered and prevented prohibited values from being entered.
Additionally, when there is only one embedded record (that contains the prohibited text as defined in the
rule), the rule will trigger but the embedded record will be added anyway. If the rule is triggered, the
embedded record should not be added.

Root Cause Analysis
When it come to evaluateConditons() for BaseConditionExpressionEvaluator.java, for line 327:
conditionResult = foundCounter == newAttributeValueList.size(); conditionResult needs to be true for
the action of the rule to take place, and for the provided scenario, in case of contains, foundConter
needs not be the same as the list size as there may be a condition where only few, say 2 of 5 attributes
matches the condition.

Issue: Screen reader does not announce column sorted.
Tracking Code: TC-50732
Case Number: 2023-0920-7992706
Reported Version: TCE 7.0

Workaround
None.

Pre-Requisites
Screen reader on.

Steps to Reproduce
1. Login to TeamConnect developer environment.
2. In the home page click the Column headers > My Open Matters table and sort by

ascending/descending.The state is not read by the screen reader.

Expected Results of Steps
Screen reader reads the sorted state to the user.

Actual Results of Steps
Screen reader does not read the sorted state.

Root Cause Analysis



The implementation was not there in the application and had to be introduced in the code base.

Issue: Client reporting similar Accessible Names for interactive controls that are causing issues.
Tracking Code: TC-50733
Case Number: 2023-0920-7992681
Reported Version: TCE 7.0

Workaround
None.

Pre-Requisites
Have a TeamConnect Environment.

Steps to Reproduce
First Issue:

1. Login to TeamConnect developer environment.
2. Go to the Legal tab and open the matters.
3. Hover on the edit button and it shows edit instead of accessible names. Screen reader users

may have difficulty determining the function of the button.
Second Issue:

1. Login to TeamConnect developer environment.
2. Go to the Home page and the minimize/maximize button is not having exact accessible names.

Expected Results of Steps
Accessibility Names are different enough to not cause confusion.

Actual Results of Steps
Accessibility Names are not clear to users.

Root Cause Analysis
Implemented fixed table columns widths for interactive grid for project list.

Issue: Unable to create a copy of an appointment if it has custom fields.
Tracking Code: TC-51333
Case Number: N/A
Reported Version: Version 7.1.0 TC62 Build 1982

Workaround
None.

Pre-Requisites
● A TCE 7.1 PB1 instance with the latest build
● An all-rights User
● A Custom field is added in the appointment like a Text field

Steps to Reproduce
1. Log in to the TeamConnect application.
2. Create an appointment, inputting a value in the custom field.



3. Open the newly created appointment.
4. Click on "Create a Copy."
5. Observe the resulting page.

Expected Results of Steps
When the user clicks on "Create a Copy," the system should generate a duplicate of the existing
appointment.

Actual Results of Steps
A fatal error is displayed if the appointment has a custom field.

Root Cause Analysis
The initial error handling did not account for scenarios where non-office custom fields were present but
not office custom fields. Our error handling has been updated accordingly.

Issue: Undefined special characters are adding up while trying to add a Portal pane title with Double
Quotation(" ").
Tracking Code: TC-49421, SUPPORTPRI-67636
Case Number: None
Reported Version: None
Workaround
None.

Pre-Requisites
● TC 7.1 instance.
● An All Right User.

Steps to Reproduce
1. Login to Team Connect with all rights users.
2. Click on Setup.
3. Select Portal Pane from GO TO Drop Down.
4. Click on the New button.
5. Type your choice of Title inside the Title input box with double quotation (e.g. “Portal Pane“).
6. Type relevant Unique Key.
7. Click on Save and Close.
8. Observe the Portal Pane title added.

Expected Results of Steps
Portal pane title should allow users to add input with Double Quotation (" ") and no other undefined
special character should come up.

Actual Results of Steps
Undefined special characters are adding up while trying to add a Portal pane title with Double Quotation
(" ").

Root Cause Analysis
“https://bitbucket.org/mitratechdev/%7B8a7d8976-1855-4e83-b0f7-da7d937e9794%7D/pull-requests/8
942 &
https://bitbucket.org/mitratechdev/%7B8a7d8976-1855-4e83-b0f7-da7d937e9794%7D/pull-requests/97



91” are two ways to avoid XSS vulnerability merged over branch patch/6.3.6 and patch/7.0.0
respectively. Somehow both the solutions got merged to 7.1 and started causing this issue. Therefore
reverting
“https://bitbucket.org/mitratechdev/%7B8a7d8976-1855-4e83-b0f7-da7d937e9794%7D/pull-requests/8
942 changes in patch/7.1.0” should fix this issue.

Security Updates
Below issue is fixed as security update:

Issue: Undefined special characters are adding up while trying to add a Portal pane title with Double
Quotation(" ").
Tracking Code: TC-49421, SUPPORTPRI-67636
Criticality: Medium



Known Issues
The following items are known issues in the TeamConnect Enterprise® 7.1 Patch Bundle 1 release.
Each issue is documented in the following format:

● A description of the issue
● Workaround
● Internal tracking code

Issue: Add-In is not supported on the Safari Browser (this is a Safari-related issue, not TeamConnect).
Tracking Code: TC-49952
Workaround: To address this issue, please use the desktop version of Outlook or another browser
such as Chrome, Edge, or Firefox.

Issue: The connector does not update Graph API credentials when changed in settings.
Tracking Code: TC-51792
Description: The graph connection credentials are stored in the client object and are not updated even
after changes are made in the settings. Therefore, a Graph API operation occurred before the correct
graph credentials were entered, resulting in the client secret remaining null.
Workaround: To address this issue, please restart the TeamConnect application.

Issue: Configuration Issue - On TeamConnect, the Matter name is Prepending with Appointment Title.
Tracking Code: TC-51799
Description:When creating an appointment in Outlook, the Matter Name is prepending with the
Appointment Title. It is observed that prepending works correctly for the "Name only" Project Unique ID
format, but not for other formats of Unique ID.

Issue: Custom icons for a few portlets are missing.
Tracking Code: TC-51179
Description: Custom icon style family is missing on a few portlets as mentioned below:

● ActionsInsightPortlet
● InvoiceSearchViewInsightsPortlet
● SearchViewSingleInsightPortlet
● SearchViewlistInsightPortlet
● DoubleSearchViewInsightPortlet

Issue: Parameters updated for a portlet are not reflecting in the frontend.
Tracking Code: TC-51034
Workaround: Once the user edit the parameters in the portal pane, they have to close the portal pane
page and reopen to load the latest parameter values and then synchronize settings and content.



Issue: For portlets, the dates displaying don't have any tags due to which, the user isn't able to
distinguish.
Tracking Code: TC-51774
Description: For portlets, the dates displaying don't have any tags due to which, the user isn't able to
distinguish (e.g. UpcomingTaskAndAppointmentsPortlet).
Portlets Affected:

● UpcomingTaskAndAppointmentsPortlet.
● RecentlyViewedInsightPortlet.
● SearchViewListInsightPortlet.

Issue: New Contact link from ActionsInsightPortlet is navigating to the New Company creation page
instead of New Person.
Tracking Code: TC-51773

Issue: The default alignment ratio 1:1:1 is not aligning the content properly in the frontend.
Description: The default alignment ratio 1:1:1 is not aligning the content properly in frontend but it is
working good in the setup side (Content Section).
Tracking Code: TC-51793

Issue: Unexpected text being displayed instead of special characters in the Export design changes
page.
Description: When a custom object definition is created or updated, special characters that should be
displayed as part of the description column of the design changes table are replaced by random text on
the Export design changes page.
Tracking Code: TC-51759

Issue: In the setup menu, an error is displayed during new New Home page creation upon clicking
synchronization settings.
Tracking Code: TC-52107



The fixes in this patch will be merged into TCE 7.2.

Installation

Important: Stop your TeamConnect® instance before updating any files in the TeamConnect® war file.

1. Replace WAR file
This patch requires replacing the entire .war file due to the number of files/libraries affected,

1. Grab the patched .war file.
2. Place/replace all the configuration files from your existing .war file into the patched .war

file.
a. teamconnect.properties
b. web.xml
c. weblogic.xml
d. weblogic-application.xml
e. any ssl certificates

3. Redeploy the new .war file.

2. Update database and version information
Use the following steps to update the database and add patch version information to the About
page of the Admin Settings.

1. Stop the TeamConnect® instance if it is currently running.
2. Backup your TeamConnect® database.
3. Run the script, located in \update, that is appropriate for your database server:

a. MSSQL_TeamConnect_710_PatchBundle_1.sql
b. Oracle_TeamConnect_710_PatchBundle_1.sql

4. Restart TeamConnect®.

Upgrade Considerations

No significant upgrade considerations for this patch.

Level of Risk to Update with Patch

LOW


